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Important Note, Please Read Carefully

Study Tips

This product will provide you questions and answers along with detailed explanations carefully compiled
and written by our experts. Try to understand the concepts behind the questions instead of cramming the
questions. Go through the entire document at least twice so that you make sure that you are not missing
anything.

Further Material

For this test TestKing also provides:

* Interactive Test Engine Examinator. Check out an Examinator Demo at
http://www.testking.com/index.cfm?pageid=724

Latest Version

We are constantly reviewing our products. New material is added and old material is revised. Free updates
are available for 90 days after the purchase. You should check your member zone at TestKing an update 3-4
days before the scheduled exam date.

Here is the procedure to get the latest version:
1. Go to www.testking.com

2. Click on Member zone/Log in
3. The latest versions of all purchased products are downloadable from here. Just click the links.

For most updates, it is enough just to print the new questions at the end of the new version, not the whole
document.

Feedback
Feedback on specific questions should be send to feedback@testking.com. You should state: Exam number
and version, question number, and login ID.

Our experts will answer your mail promptly.
Copyright
Each pdf file contains a unique serial number associated with your particular name and contact information

for security purposes. So if we find out that a particular pdf file is being distributed by you, TestKing
reserves the right to take legal action against you according to the International Copyright Laws.
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Note:

Section A contains 98 questions.
Section B contains 59 questions.

The total number of questions is 157.

Section A — more important questions
Study these questions carefully.

QUESTION NO: 1
You created a custom menu for the Order Entry application. Which step do you perform before
attaching the menu module to the form module?

Select file-->Administration-->Convert
Select file-->Administration-->Execute
Select file-->Administration-->Compile File
No further step is necessary.

Sowp

Answer: C

Explanation: After creating the custom menu you need to compile the menu to create the . MMX file for
that menu. that is done by selecting the menu file=> Administration=>Compile File from the main menu in
Oracle Form Designer. Then you have to attach the menu module after compiling it.

QUESTION NO: 2
You want to create a pie-style chart using the Chart Wizard. What must be you do to determine the
fields available for use in this chart?

A. Select the block that contains the data to appear in the pie chart.
B. Select the table that contains the data to appear in the pie chart.
C. Select the view that contains the data to appear in the pie chart.
D. Nothing. The wizard will automatically create the pie chart based on the highlighted data.

Answer: A

Explanation: When creating a pie chart using the Chart Wizard ONLY Block names will be listed in the
chart wizard and you can not make a selection from the wizard to select a specific table or view, Chart
Wizard takes data from Data Blocks only.

QUESTION NO: 3
Which three menu item types are valid in a menu module? (Choose three)

A. Magic
B. Plain
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C. Check
D. Listitem
E. Divider

Answer: A, B, C

Explanation: Magic menu item type is used to specify standard actions such as Cup or Copy. Plain is a
standard test menu item and Check menu item type is used to menu as two possible states Checked and
Unchecked . List item and Divider are not a valid types for menus.

QUESTION NO: 4

You need to return a table of records that displays the account numbers of all user’s customers, but
displays NULL for the account number of other customers.

Which type of data source would you use to create the data block?

Table

Transactional trigger
Stored procedure
FROM clause query

oOwp

Answer: C

Explanation: Data Block can be based on Stored Procedure that return either REF Cursor or Table or
records. The Returned table of records can contain any select statement programmed in the Stored
Procedure. Which can be used to display NULL for account number of other customers. Table of records
will send the entire records to the client then client can do DML or query operation at the client side.

QUESTION NO: §
The system analysts have requested heavy use of object features. The database design makes use of
PL/SQLS object types, methods, and LLOB types. How do you work with these features on the client?

A. Write client-side subprograms containing the PL/SQLS constructs, and move them into an object
group.

B. Write server-side subprograms, and call the subprograms from the form application.

C. Store the PL/SQLS constructs in a PL/SQL library, and attack the library to each form muddle in
your application.

D. You cannot reference PL/SQLS object types in your application.

Answer: B
Explanation: Forms can use PL/SQLS objects when they are stored on the server as subprograms which can
be called from the application on the client. The following feathers are supported in database server
PL/SQLS but are not supported in Forms Builder module :

1- Object types

2- Collection types
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3- LOB types
4- Methods
5- Objects as stored procedure parameters

QUESTION NO: 6
You CUSTOMERS module has a When-Button-Pressed trigger with this code:
OPEN FORM( ‘stock’, no_activate);

The STOCK module contains a When-New-Form-Instance trigger.
Which statement is true when you press the button in the CUSTOMERS module?

A. The input focus switches to the STOCK module, and the When-New-Form-Instance trigger fires.

B. The input focus remains in the CUSTOMERS module, and the When-New-Form-Instance trigger
fires.

C. The inout focus remains in the CUSTOMERS module, and the When-New-Form-Instance trigger
does not fire.

D. The input focus switches to the STOCK module, but the When-New-Form-Instance trigger does not
fire.

Answer: B

Explanation: Using the OPEN_FORM to open forms in Forms builder will cause the form to be opened in
modeless view which means users can navigate to the form and to the calling form, no_activate parameter of
OPEN_FORM method will not activate the form when opened but it will fire the trigger When-New-Form-
Instance if it’s available in the called form. Since the called form will not be activated hence focus will
remain in the calling from “CUSTOEMRS” and will fire the When-New-Form-Instance trigger of the
STOCK Form.

QUESTION NO: 7

You are building two forms. Each form has a button and a non-base table field. When the button is
pressed, a complicated calculation is executed. The calculation is the same for both forms. The
calculation code does not query or change the data in the database. When the calculation completes, it
returns a single value to the non-base table field.

To optimize performance and maintainability, which PL/SQL structure should be used?

A. A trigger in each form.

B. A subprogram in each form.

C. A stored subprogram in the database.

D. A subprogram in a library that is attached to each form.

Answer: D

Explanation: Because the process required is to do calculations which is the same for both forms and no
need to access database or change values in the tables and the result is a single value then the option of
storing it as a subprogram in a library then attach it to each form will save you the time to create the same
functionality twice for each forms more over you can maintain the code easily because on code will be
attached for both forms as a library.
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QUESTION NO: 8

A sales analyst reviews the first draft on your Sales application, and requests that the application
graphically represent revenue generated for each sales representative, in addition to the textual data
currently displayed for the ORDER block.

How would you incorporate this graphic in your form?

A. Invoke the Chart Wizard and create a chart based on the ORDER block.

B. Create a chart using Graphics Builder and then select File=> Import Chart in Form Builder,
positioning the new chart with the text items in the ORDER block.

C. Invoke the Data Block Wizard in reentrant mode, select the Charts tab, and specify the chart type and
column sources for the X and Y axes.

D. Select the Chart node in the Object Navigator, Click the Create icon, and specify the details of the
chart in the chart’s Property Palette.

Answer: A

Explanation: Graphical representation is done be using the Chart Wizard to create charts of different types.
Charts will represent the data available in the source block. Charts can not be created from the object
navigator, Changing also can be done by the Chart Wizard. Data Bock wizard can not create charts.

QUESTION NO: 9
You want to implement a master-detail relation between data blocks based on object tables. How
would you do this?

Create the relation manually and coordinate the blocks using triggers.

Base the relation on a REF pointer using the Data Block Wizard.

Base the relation on a foreign key using the Data Block Wizard.

This task is not possible because master-detail relations can be implemented only for blocks based on
relation tables.

Sowp

Answer: B

Explanation: Relation can be created on blocks based on objects table using the Data Block Wizard. When
you select the Master Table from the wizard and the Child Table REF pointers will be listed in the wizard as
items which can be used to base the relation of both blocks. Selecting the REF pointer is the only thing
needed to base the relationship.

QUESTION NO: 10

You established access to menu modules using roles. You have allowed the sales role to access the
menu module, but prevented access to the Update menu item. Which item property would you alter to
gray out the menu option for the role?

Item Roles.

Menu Item Roles.
Display without Privilege.
Use Security.

oCOowpx>
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E. Command Type.

Answer: C

Explanation: When access is established in the menu module using roles. Each menu will be given the
permission based on Oracle Server Roles created by DBA. The Display without Privilege item property in
the menu will Disable “gray out” the menu item if user does not belong the role that have access to this
menu item.

QUESTION NO: 11
You create a data block based on a relational table containing a REF column. You select the REF
column for your form module. What is true about the items based on the REF column attributes?

A. The Query Only property is set to Yes.

B. The Conceal Data property is set to Yes.

C. The Insert Allowed property is set to Yes.
D. The Update Allowed property is set to Yes.

Answer: A

Explanation: If form contains blocks based on relational tables containing REF Columns. The REF column
will be an item with property Query Only is set to YES automatically. Conceal Data and Insert allowed and
Update Allowed property are set to NO.

QUESTION NO: 12
Which technique retrieves the error number when explicit DML fails?

SQLCODE in an On-Error trigger.

SQLCODE in an exception handler.

DBMS ERROR CODE in an On-Error trigger.
DBMS ERROR_CODE in an exception handler.

oW

Answer: B

Explanation: SQLCODE and SQLERRM returns the last Oracle Server error code and message due to an
explicit DML within a form application. These function must be used in the exception handler of the
program unit that issues the DML command. DBMS ERROR_CODE return the last Oracle server error due
to an implicit DML fail.

QUESTION NO: 13
Which two built-ins would you use to remove the HOUR_ALARM timer using the timer_id
parameter? (Choose two)

FIND TIMER
CREATE TIMER
SET TIMER
DELETE TIMER

oSOowpx>
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E. GET_APPLICATION_ PROPERTY

Answer: A, D

Explanation: To remove the timer FIND_ TIMER is used to retrieve the Timer ID in the application. Timer
ID is used in the method DELETE_TIMER to delete the timer. GET APPLICATION PROPERTY is used
to retrieve the last expired timer, CREATE TIMER is used to create a timer, SET TIMER used to change
the existing timer property.

QUESTION NO: 14
Which built-in returns a BOOLEAN value that indicated whether an objects internal ID is available?

GET_ID

ID NULL
ID_FIND
FIND_ID

oCOowp>

Answer: B

Explanation: ID NULL Return Boolean that represent if the object has internal ID in the application. If ID
exist it returns FALSE and if ID does not exist it return TRUE . FIND_ID returns the internal ID of the
object. GET ID and FIND ID do not exist in oracle forms.

QUESTION NO: 15
Which built-in do you use to determine which timer in form module has expired?

FIND TIMER

GET_TIMER PROPERTY
GET_APPLICATION PROPERTY

GET _CUSTOM _ITEM_EVENT PROPERTY

oOwp

Answer: C

Explanation: When the timer expires it’s included in a queue till the application is idle to delete the timer,
each expired timer is taken by First-In-First-Out. GET APPLICATION PROPERTY is used to determine
the last timer expired in the application. FIND TIMER is used to get the internal ID of the timer.

GET _TIMER PROPERTY is used to change specific timer property

QUESTION NO: 16
Which three objects are components of a menu module? (Choose three)

Menus

Canvases

Object libraries
Visual attributes
Attached libraries

moQwy
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Answer: A, D, E

Explanation: When menu is created it will contain the menus that is created using the Menu Editor tool and
it will also include the Visual Attributes and Attached libraries. When menu is created it has to be compiled
to .mmx file and attached to the from module to be implemented.

QUESTION NO: 17

You need to create a form for Payroll application that will allow the user to view all information for
any employee ID queried. This data should be displayed to the user in a grouped format. The user
should be able to choose which information they want to see from a pull down list containing the
values PERSONAL and PAYROLL.

Which format should you use to create this form?

One content canvas and multiple stacked canvases.
One content and one stacked canvas.

Tab canvas with several tab pages.

One content canvas.

A horizontal and vertical toolbar.

mONwy»

Answer: A

Explanation: Content canvas occupies the entire content area of the window and stacked canvas can be
displayed and overlay some portion of the content view on the same window. If data should be displayed in
grouped format then only one content canvas should be used and multiple stacked canvases used to display
the related grouped data..

QUESTION NO: 18
Which built-in copies values from a record group into a list item?

POPULATE LIST

POPULATE GROUP
POPULATE LIST ITEM
POPULATE LIST FROM_GROUP
POPULATE_LIST ITEM FROM GROUP

moaowy

Answer: A

Explanation: List item can copy values from Record Group to it’s items by using the POPLULATE LIST,
POPULATE_GROUP is not a valid method. Record Group should be created first and assigned values prior
copying it’s value to a list item.

QUESTION NO: 19
You need to allow the user to toggle between automatic query and no automatic query using a pop-up
menu. Which built-in would you use in the menu item command to obtain the relationship name?

GET_RELATION PROPERTY
SET_RELATION PROPERTY
GET _BLOCK_PROPERTY
GET FORM_PROPERTY

Sawp>
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Answer: C

Explanation: GET BLOCK PROPERTY is used to get block related properties including the relationship
name. SET _RELATION PROPERTY is used to change any property of the specific relation.

GET _RELATION_ PROPERTY is used to retrieve relation specific property.

QUESTION NO: 20
Which two chart base types can you select using the Chart Wizard? (Choose two)

Line

Column

Bubble

Flowchart

OHLC candle stock.

moONw»

Answer: A, B

Explanation: When Chart Wizard is used to create charts it will provide with specific number of chart types
to be used. It provides types such as Line, Column, Bar, It does not provide Bubble, FlowChart or OHLC
Candle stock.

QUESTION NO: 21
Which two are examples of a mouse event? (Choose two)

The user clicks the mouse.

The user moves the mouse into an item.

The cursor style changes from default to busy.

The user moves the mouse into the window title bar.

Sawp>

Answer: A, B

Explanation: Mouse events are the events triggered by the mouse such as Click or moving the mouse
pointer over and item. Mouse movement is not included in the window title bar because mouse events are
not handled there. Changing Cursor style is not a mouse event.

QUESTION NO: 22
Your application requires that you programmatically manipulate a nonquery record group. Which
three built-ins can you use? (Choose three)

CREATE_GROUP
ADD GROUP ROW
POPULATE _GROUP
ADD_GROUP_COLUMN

oCawx>
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E. CREATE GROUP FROM QUERY

Answer: A, B, D
Explanation: To create nonquery record group you must create the group first using CREATE _GROUP
then add a new column using ADD_GROUP_COLUMN then add new row using AGG_GROUP_ROW

Example :
DECLARE

MyRec RECORDGROUP;
MyCol GROUPCOLUMN;
BEGIN

MyRec := CREATE_GROUP (‘warehouse_rg');
MyCol := ADD_GROUP_COLUMN (MyRec,'id",number_column);
ADD_GROUP_ROW (MyRec, 1);

QUESTION NO: 23

The accounting manager wants you to create a form that when queried will display a calculated total
of year-to-date actual expenditures for the fund code entered. The value needed to generate this
summary data are stored in multiple tables.

How would you define the data source for this data block without having the DBA create a database
object?

A. Choose Tools -> Data Block Wizard, select View as the data source type, and base the block on the
columns from the bales.

B. Choose Tools -> Data Block Wizard, select Table as the data source type, and base the block on the
columns from the tables.

C. Select the Data Blocks node in the Object Navigator and click the Create button.
Choose to build the data block manually and alter the Query Data Source Columns and Query Data
Source Arguments properties to enter the SELECT statement.

D. Select the Data Blocks node in the Object Navigator and click the Create button.
Choose to build the data block manually, alter the Query Data Source Type property to ‘Table’, and
enter the SELECT statement in the Query Data Source Name property.

E. Choose Tools -> Data Block Wizard, select Stored Procedure as the data source type, and base the
block on the columns the tables.

F. Select the Data Blocks node in the Object Navigator and click the Create button.
Choose to build the data block manually. Alter the Query Data Source Type to ‘FROM’ clause
query’, and enter the SELECT statement in the Query Data Source Name property.

Answer: F

Explanation: Data block based on “FROM?” clause can retrieve data from multiple table in the database
without the need to create any object in the database server. This is done by creating the Data Bock
manually in the Object Navigator and specify the Data Source type as “FROM” Clause query and enter the
SELECT statement in the Query Data Source Name Property.

QUESTION NO: 24

Leading the way in IT testing and certification tools, www.testking.com

-12 -



1z0-132

The EMP_DEPT block in your EMPLOYEE form is based on a view in an Oracle8 database. The
items in this block have the Update Allowed property set to Yes. Which database feature makes it
possible to permanently modify the underlying view?

REF cursor.

Instead Of trigger.

Stored procedure that returns object values.

The underlying view cannot be modified because DML on a view is not supported.

oOwp

Answer: B

Explanation: When the Update Allowed property is set to YES and the block is based on view on the
database server, Instead Of Triggers should be used to update the underlying tables that the view depends
on. This trigger will fire whenever the user updates a value through the view. REF Cursors and Stored
Procedures that returns object values will not update the values in the underlying view in the server. Views
can not be modified using DML operation unless instead of trigger exists.

QUESTION NO: 25

You are developing the Payroll application that contains the SALARY and COMMISSION forms.
When a user invoked the COMMISSION form from the SALARY form, the SAL value should be
passed to the COMMISSION form. In which data form and at what time should you define the
parameter to accept the value?

SALARY form at runtime.
SALARY form at design time.
COMMISSION form at runtime.
COMMISSION form at design time.

oCOowx>

Answer: D

Explanation: If the called form will contain parameter value then the parameter should be created at design
time in the called form “COMMISION FROM”, Then in the calling form “SALARY” form will have to
create a parameter and assign it a value using CREATE PARAMETER LIST and ADD PARAMETER
which will create a parameter list that includes the specific parameter which is then used in the
OPEN_FORM method to open the COMMISSION form and pass the value of parameter to the
COMMISION form.

Example :

declare

MyParameter PARAMLIST;

begin

MyParameter := CREATE_PARAMETER_LIST(‘'wh_pl’);

ADD_PARAMETER (MyParameter , ‘wh_param',TEXT_PARAMETER,:Commision_id);
OPEN_FORM('COMMISION', ACTIVATE, NO_SESSION,NO_SHARE_DATA, 'wh_pl');
end;

here wh_pl Is the parameter list and MyParameter is the parameter to be passed

Leading the way in IT testing and certification tools, www.testking.com
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QUESTION NO: 26
At design time, you create a query record group for the LOV associated with the HOTEL text item in
a form module for the Travel Planner Application. When is the record group deleted?

A. When the user navigates to the HOTEL item.

B. When the form module successfully compiles.

C. After Form Builder validates the SELECT statement and dismisses the New Record Group dialog
box.

D. When the user enters data in the HOTEL item, and the Validate from List property for the HOTEL
item is set to YES.

Answer: D

Explanation: When LOV that contain record group value attached to a text item the record group will be
deleted when user enters data in the text item. This will be if the text item Validate from List property is set
to YES. Successful compilation of the form will not delete the record group neither navigation to the text
item.

QUESTION NO: 27
Which object is added to a form module when you copy the reusable calender class?

List icon

Object group
PL/SQL library
Key-Listval trigger

Cawp>

Answer: B

Explanation: Calendar class when used in the form module will automatically add Object Group and Data
Blocks. Key-Listval trigger can be used to display the calendar but it has to be programmed manually not
automatically.

QUESTION NO: 28
You developing a form module, and you would like to make an indicated window visible in a new
display position. Which built-in can you use to accomplish this task?

SHOW_WINDOW
RESIZE_ WINDOW
DISPLAY WINDOW
MOVE_WINDOW X Y
WINDOW VISIBLE X Y

moO 0wy

Answer: A

Explanation: The syntax of Show window is as follow :

SHOW_WINDOW (window_id Window ,x NUMBER ,y NUMBER) where x and y are the position in
coordinates in the screen. RESIZE WINDOW is used to resize the window, DISPLAY WINDOW,
MOVE _WINDOW_X Y and WINDOW _VISIBLE X Y are not a valid command,

Leading the way in IT testing and certification tools, www.testking.com
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QUESTION NO: 29

You are creating the CUST_PREMIUM data block in the AUTO_INSURANCE form. A new state
law requires that premiums be lowered for drivers with a good driving history. Because this could

potentially affect a large number of records, you want to base the data block on a stored procedure
returning a table of records.

Which statement supports this approach?

A. A table of records is efficient in terms of network traffic.

B. A table of records improves developer productivity because the database administrator does not have
to create a server side view.

C. A table of records is efficient because the number of records fetched depends on the Array Fetch
property value.

D. Your coding effort is simplified since DML operations are handles by setting form module
properties.

Answer: A

Explanation: When stored procedure returns a table of records it transfers all the records to the client in one
unit so round trip to the server is not necessary so its efficient in term of network traffic. Table or records
does not improve developer productivity because all the code is created in the Stored Procedure by database
administrator. Number of records returned is specified by Array Fetch Property value if REF Cursor is
returned not table of records.

QUESTION NO: 30
What does the FIND MENU_ITEM built-in function return?

A. The internal ID of a menu.

B. The internal ID of a menu item.

C. The internal ID of a menu module.

D. The internal ID of form module to which the menu is attached.

Answer: B
Explanation: FIND MENU ITEM returns menu item type. Example :

PROCEDURE Toggle AutoCommit Mode IS

mi_id Menultem;

val VARCHARZ2(10);

BEGIN

mi_id := Find Menu_Item(’Preferences. AutoCommit’);

val ;= Get Menu_Item Property(mi_id, CHECKED);
IF val ="TRUE’ THEN
Set Menu_Item_ Property(mi_id, CHECKED,PROPERTY FALSE);
ELSE
Set Menu_Item Property(mi_id, CHECKED,PROPERTY_ TRUE);
END IF;

Leading the way in IT testing and certification tools, www.testking.com
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END;

QUESTION NO: 31

You established access to menu modules using roles. While testing the application, you need access to
all the menus in the SALES form module for all the roles. Which method will override the Menu
Module Roles property to allow you to access all the menu items?

Disable the values for the Menu Module Roles property.

Set the Use Security value in the form module Property Palette to ‘True’.
Set the Use Security value in the form module Property Palette to ‘False’.
Set the Use Security value in the menu module Property Palette to ‘True’.
Set the Use Security value in the menu module Property Palette to ‘False’.

monQwy

Answer: E

Explanation: To disable security on the menu module the Use Security property value should be set to
FALSE on the menu module. Forms menu security is based on Oracle Server roles. These roles are created
in the database, typically by the database administrator. After the roles have been created, the Module Roles
menu module property can be assigned to these roles. The next step is to assign the chosen roles to the
individual menu items. The user executing the form with this menu attached must be assigned to this role to
activate that menu item.

QUESTION NO: 32
You include the calendar class in your Hotel Booking application. Which additional form level objects
will you need to create to implement this reusable component fully?

Blocks

Visual attributes.

Stacked canvas.

Nothing further needs to be created.

ocaowp

Answer: D

Explanation: The calendar object group includes two data blocks. The Date control block contains the
month and year control buttons and the Date button block contains the buttons that represent each day.
These buttons and other items are stored on the Date lov_canvas canvas. This canvas is included in the

calendar object group. Nothing further needs to be created when calendar class is used.

QUESTION NO: 33
You need to create a data block for DML operations in the NEW_EMPLOYEE form module. Which
data source can you use for this block?

REF cursor query.
Stored function.
From clause query.
Transactional trigger.

oCaw>
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Answer: D

Explanation: Data Block can be based on Stored Procedure that returns REF Cursor or Table of Records or
it can be based on “FROM?” clause query. REF Cursor and “FROM” query types do not allow DML
operations and Table of recodes allows DML operations. Similarly Transactional Triggers can do DML
operations.

QUESTION NO: 34
You are creating a form that will access an Oracle8 database. On which three sources can you base a
data block? (Choose three)

BFILE

REF column

Object table

Column object
INSTEAD-OF trigger

mONwy»

Answer: B, C, D

Explanation: Data Block can be based on Stored Procedure that returns REF Cursor or Table of Records or
it can be based on “FROM?” clause query. REF column and Column object and Object table can be selected
from the Data Block Wizard. BFILE and INSTEAD-OF Triggers are supported in Oracle Forms but can not
be used as sources of Data Block.

QUESTION NO: 35
Which three statements describe the functionality of the DO_KEY built-in? (Choose three)

It accepts both a built-in and a key name as argument.

If no key trigger is defined, the specified built-in executes.

Its parameter must be specified in upper case, enclosed in single quotation marks.

It performs the same task as if you pressed the function key associated with the specified argument.
It executes the key trigger that corresponds to the built-in specified as its parameter.

moQwy

Answer: B, D, E

Explanation: The DO_KEY built-in function executes the key trigger associated with the built-in that is
specified as its parameter. If no associated key trigger exists, then the specified built-in subprogram
executes. For example, DO KEY('EXIT FORM'), when executed, will search for a Key-Exit trigger. If it
does not find a Key-Exit trigger, it will execute the EXIT FORM built-in. DO_KEY accepts built-in names
only, not key names: DO _KEY(ENTER QUERY). To accept a

specific key name, use the EXECUTE TRIGGER

QUESTION NO: 36
You are creating a new form for the Order Entry application. You define a record group that will be
created when the form is executing this built in:

CREATE GROUP (rg _emplist, global scope)
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Which form(s) in the application will have access to this record group?

All forms in the application.

Any forms opened by the user who initiated the record group.
Only the form issuing the CREATE _GROUP built-in.

Any forms referenced by the form that contains the procedure.

Tow»

Answer: A

Explanation: The SCOPE parameter in the CREATE GROUP built-in Specifies whether the record group
can be used only within the current form or within every form in a multi-form application. LOBAL SCOPE
Indicates that the record group is global, and that it can be used within all forms in the application. Once
created, a global record group persists for the remainder of the runtime session.

QUESTION NO: 37
Which built-in would you reference in your trigger code to remove a report from the Reports Server
queue dynamically?

FIND REPORT OBJECT

CANCEL REPORT OBJECT
REPORT_OBJECT_STATUS

SET _PROPERTY OBJECT PROPERTY

SRl s

Answer: B

Explanation: The CANCEL REPORT_OBJECT built-in cancels a long-running, asynchronous report. You
should verify the report is canceled by checking the status of the report using REPORT OBJECT STATUS.
The SET_ REPORT OBJECT PROPERTY built-in is used to change report properties programmatically.
The DELETE TIMER built-in deletes the given timer.

QUESTION NO: 38
What does the term application partitioning refer to?

A. The feature of a forms application enabling it to run both in client-server mode and on the Web.

B. Storing PL/SQL program units between the Oracle server and the application to make optimal use of
available resources.

C. The nature of a three-tier architecture, where the form module and processing software reside on an
application server.

D. The feature of a forms application that is able to use Ethernet, twisted pair, and wireless data
connections.

Answer: B
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Explanation: PL/SQL program units can be stored in Oracle Server and in the application at the client side.
Making such a division will allow optimal use of resources at the server and client because jobs will be
divided between the server and client. This applies the term Application Partitioning.

QUESTION NO: 39
Which three built-ins can you use to navigate between forms invoked with the OPEN_FORM built-
in? (Choose three)

CLOSE_FORM
NEXT FORM

GO _FORM
PREVIOUS FORM

Cawp>

Answer: B, C,D

Explanation: OPEN_FORM opens the form in modeless mode so that users can switch between calling
form and called form. To navigate to the form NEXT FORM, GO _FORM and PREVIOUS FORM can be
used. CLOSE FORM will close the indicated form.

QUESTION NO: 40
Which two triggers are mouse movement triggers? (Choose two)

When-Mouse-Up
When-Mouse-Move
When-Mouse-Down
When-Mouse-Click
When-Mouse-Leave

moONwy

Answer: B, E

Explanation: Mouse movement triggers are Moving mouse over an item or canvas “WHEN-MOUSE-
MOVE” or mouse pointer leaves item box or canvas “WHEN-MOUSE-LEAVE”. MOUSE-UP, MOUSE-
DOWN and MOUSE-CLICK are actions of mouse buttons and not considered mouse movement triggers.

QUESTION NO: 41

The record group in the EMP form is populated using a SELECT statement that is constructed
programmatically at runtime. Five employee records are displayed at one time, and a user chooses
item two from the record group. Which built-in would you use to determine which rows were flagged
in the record group?

A. GET_GROUP_ROW_COUNT
GET_GROUP_SELECTION_COUNT
GET _GROUP SELECTION
FIND_GROUP

FIND_COLUMN
ADD_GROUP_ROW

mmoaw
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Answer: C

Explanation: GET GROUP_SELECTION Retrieves the sequence number of the selected row for the given
group. The GET_GROUP_SELECTION_COUNT built-in returns the number of rows in the specified
record group that have been marked using the SET _GROUP_SELECTION built-in.

QUESTION NO: 42
You want to create a temporary table while executing a procedure in a form.
Which statement is true?

You cannot create a table form within Forms.

You must use the FORMS_DDL built-in to create the table.

You must use the DBMS DYNAMIC DDL package to create the table.
You can write the CREATE TABLE statement directly into the trigger.

oCOowpx>

Answer: B

Explanation: The FORMS DDL built-in allows you to create dynamic SQL statements at runtime and to
issue DDL commands. All DDL operations issue an implicit COMMIT and will end the current transaction
without allowing Form Builder to process any pending changes, as well as losing any locks Form Builder
may have acquired.

QUESTION NO: 43
Your end users will need to change values in a REF lookup field in the form application you create.
To facilitate choosing a new appropriate value, your provide them with?

An LOV for REFS.

A list item for REFs.

A radio group for REFs.

A hierarchical tree for REFS

TOwp

Answer: A

Explanation: LOV is used to display REF lookup field because the same LOV gets attached to all the
lookup items associated with a particular REF. List item, radio group and hierarchical tree are not used for
REF lookup field.

QUESTION NO: 44
Form_A invokes Form_B in Post-Only mode.
Which statement must be true?

A. Form_A has updates or deletes that have not been posted or committed, and Form_A invokes
Form B with the OPEN_FORM built-in.

B. Form_A has updates or deletes that have not been posted or committed, and Form_A invokes
Form B with the CALL _FORM built-in.
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C. Form_A has inserts that have not been posted or committed, and Form_ A invokes Form B with the
OPEN_FORM built-in.

D. Form_A has inserts that have not been posted or committed, and Form_A invokes Form B with the
CALL_FORM built in.

Answer: B

Explanation: A form that is called from another form (with changes pending) using CALL FORM is in
post only mode. When a form is in post only mode, it cannot perform commits. Changes to the called form
must be committed along with the change in the calling form by committing in the calling form. Post-only
mode can occur when your form issues a call to another form while unposted records exist in the calling
form. To avoid losing the locks issued by the calling form, Form Builder prevents any commit processing in
the called form.

QUESTION NO: 45
Which value is valid for the iterate parameter in the CREATE_TIMER built-in function?

CYCLE
ITERATE
NO_REPEAT
REUSE

oW

Answer: C
Explanation: The syntax for the CREATE TIMER built-in is:

CREATE TIMER (timer name, milliseconds, iterate);

The value for iterate can be REPEAT or NO REPEAT. The default is REPEAT. This instructs the timer to
repeat after each expiration. It will not repeat if the timer is created using the NO REPEAT keyword.

Omitting the milliseconds parameter results in a compilation error.

QUESTION NO: 46
You need to display a very large single-record data block. Since it will be so large, a convenient means
of navigation is needed between items. Which type of canvas would you use to display the data block?

Tab canvas.

Pop up canvas.

Spread table canvas.
Vertical toolbar canvas.

oOwp

Answer: A
Explanation: Tab canvas can be used to display large data block, It can display items which make them
easy to navigate. No Popup canvas or Spread Table canvas or vertical toolbar used to display large blocks
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QUESTION NO: 47

You need to base a data block on the EMP table, but you do not want to give the users of the
application access privileges on the table. Which type of data source would you use to create the data
block?

table

transactional trigger
stored procedure
FROM clause query

SRl s

Answer: C

Explanation: Stored Procedure used to with IN parameter to retrieve data based on the parameter sent by
the application to display different data depending on the parameter sent. A SELECT statement is assigned
to a REF cursor when it is opened using the OPEN FOR statement. Therefore, the procedure could contain
multiple OPEN FOR statements, each with a different SELECT statement. The value of the IN argument
will then be evaluated to determine which OPEN FOR statement should be executed.

QUESTION NO: 48

Examine this portion of code:

timer id := FIND TIMER('‘my_ timer’);
-- <missing code here>
DELETE TIMER (timer_ id) ;

END IF;

Select the missing code that would delete the timer.

IF timer id IS NULL THEN
IF ID NULL(timer id) THEN
IF timer id IS NOT NULL THEN
IF NOT ID NULL(timer id) THEN

Cawy»

Answer: D

Explanation : ID_ NULL Return Boolean that represent if the object has internal ID in the application. If ID
exist it returns FALSE and if ID does not exist it return TRUE . FIND_ID returns the internal ID of the
object. GET ID and FIND_ID do not exist in oracle forms. IF NOT ID_NULL(timer id) will execute when
timer id exists.

QUESTION NO: 49
Which canvas built-in display the given canvas in front of any stacked canvases?

HIDE_VIEW
SHOW VIEW

SET CANVAS PROPERTY
REPLACE_CONTENT VIEW

ooy
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Answer: B

Explanation : SHOW_VIEW Displays the indicated canvas at the coordinates specified by the canvas’s X
Position and Y Position property settings. If the view is already displayed, SHOW_VIEW raises it in front
of any other views in the same window.

QUESTION NO: 50
As an alternative to setting the Visible property to No for the ORDERS_WINDOW, which built-in
could you use to achieve the same result?

HIDE WINDOW
CLOSE_WINDOW
REPLACE CONTENT VIEW
GET WINDOW PROPERTY

SOowpx>

Answer: A
Explanation : HIDE  WINDOW Hides the given window. HIDE  WINDOW is equivalent to setting
VISIBLE to No by calling SET WINDOW_PROPERTY.

QUESTION NO: 51
When a repeating timer expires,

The When-Timer-Expired trigger resets the timer’s iteration parameter.

The When-Custom-Item-Event trigger fires and executes the desired actions.

It is put in a queue of expired timers for processing on a first-in-first-out basis.

The When-Timer-Expired trigger fires instantly regardless of any other processing in the form
module.

oCOowp>

Answer: C

Explanation : When the timer expires in sent to a queue of expired timers for processing . When the timer is
in the queue it’s processed by first-in-first-out. GET APPLICATION PROPERTY will return the last
expired timer in the list which can be processed for deletion iwht DELETE TIMER.

QUESTION NO: 52

How can you modify the application to return more meaningful error messages to the user?

A. Create a custom messages table.
Include the necessary error handling code in the form modules to display the meaningful custom
message instead of the ORA- error message.

B. Provide users with a form in the application to query the ORA- error, that will return a custom
message to replace the ORA- message.

C. Eliminate constraints where possible, thereby limiting the number of error messages returned.

D. Create a procedure to include the RETRIEVE MESSAGE built-in that automatically translates
common server errors into meaningful messages for use in Forms.
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Answer: A

Explanation : To modify error messages with meaningful error message custom messages table can be
created with meaningful error messages and On Error is used to Replace a default error message with a
custom error message, or to trap and recover from an error.

QUESTION NO: 53
You are creating a data block based on a stored procedure returning a table of records. So far, you
have defined the record type as follows:
Type emprec IS RECORD (empno emp.empno€TYPE,
ename emp.ename$TYPE) ;

Select the line of code that completes the definition of the table of records.

A. emptab emprec%TYPE;

B. CREATE TABLE emptab As emprec;

C. TYPE emptab IS TABLE OF RECORDS emprec;

D. TYPE emptab IS TABLE OF emprec INDEX BY BINARY INTEGER;
Answer: D

Explanation : A table of records is declared using the TYPE command:
TYPE reservation_tab IS TABLE OF reservation INDEX BY BINARY INTEGER;
The clause "INDEX BY BINARY INTEGER" is required to declare a table of records.

QUESTION NO: 54
Which built-in allows you to update the screen display to reflect the information that Forms has in its
internal representation of the screen?

SYNCHRONIZE

UPDATE _FORM
SYNCHRONIZE FORM
GET _MEMORY_DISPLAY
SET MEMORY DISPLAY

mONwy»

Answer: A

Explanation : The SYNCHRONIZE built-in updates the screen display to reflect the information that Form
Builder has in its internal representation of the screen .

QUESTION NO: 55

You created a custom menu for the Order Entry application. The shipping administrator has
requested an additional submenu containing four items to invoke various reports.

Which command type must you use to identify the parent menu item as a submenu?
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Menu
Plus
Macro
PL/SQL

oCOowx>

Answer: A
Explanation : There are three types of menus: main, individual, and submenu. The Menu can be used to
identify menu item or parent menu item in case it’s used in submenu.

QUESTION NO: 56

The accounting manager wants you to create a form that when queried will display a calculated total
of year-to-date actual expenditures for the found code entered. The values needed to generate this
summary data are stored in multiple tables.

Which data source type can you assign to the data block for this form without having the DBA create
a database object?

database table
transactional trigger
stored procedure
FROM clause query
client-side procedure

moawy

Answer: D

Explanation : The From clause data source enables you to create a block based on a SELECT statement.
This is similar to basing a block on a view, however, the view does not have to be created in the database.
When a query is executed on this type of block, the SELECT statement is sent to the database, and the
resultant rows are returned to the block. Use this data source in place of creating a database view or table.
However, unlike a table or view, DML operations are not allowed.

QUESTION NO: 57
Where can you add your own PL/SQL code in relation-handling triggers?

Before the “End default relation program section” comment.

After the “Begin default relation program section” comment.

Before the “Begin default relation program section” comment.

It is not possible to modify the relation-handling code that Forms automatically creates for relations.

oCawpx>

Answer: C

Explanation : Relation-Handling triggers are created automatically when relation is built between Master
and Detail blocks. Relation-handling will have comments inserted automatically Before the “Begin” and
after the “End” default sections to allow users to replace them with developer PL/SQL custom code.

QUESTION NO: 58
Which value is valid for the iterate parameter in SET_TIMER built-in procedure?
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REUSE
RECYCLE

NO CHANGE
OCCURRENCE

oSOowx>

Answer: C

Explanation : SET TIMER Changes the settings for an existing timer. You can modify the interval, the
repeat parameter, or both. The parameter NO_CHANGE Specifies that the milliseconds property is to
remain at its current setting.

QUESTION NO: 59

You create a data block based on a relation table containing a REF column. You select the REF
column for your form module.

Which statement about the REF column is true?

It is created as a nondisplay item.

The Lock Record property is set to Yes.

It cannot be referenced in item level triggers.

It is placed on the canvas with the highest sequence number.

oOwp

Answer: A

Explanation : When creating a data block based on a table that contains a REF column, the Data Block
Wizard will display two instances of this type of column. The first instance is the regular object column and
all of its attributes. Selecting the attributes of this instance creates normal items in the data block. The
second instance is the REF itself. Choosing this instance creates a nondisplay item on a null canvas.

QUESTION NO: 60
Which three objects can be components of a menu module? (Choose three)

windows
parameters
object groups
report objects
visual attributes

moOnwx

Answer: B, C, E

Explanation : Menu module components could be parameters which can be passed between menu item and
forms. Also menu module component could be Object Group and Visual Attributes.

QUESTION NO: 61

You create a package that contains PL/SQL variables that must be shared among several forms in the
Travel application. You place the package in a library and attach the library to all the forms that need
to share the data.
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Which parameter in the OPEN_FORM built-in must you set to ensure that changes made by one
form are visible to the other forms in the application?

data_mode
paramlist
query_mode
session_mode

oOwp

Answer: A

Explanation : Use OPEN_FORM to create multiple-form applications, that is, applications that open more
than one form at the same time. Data mode value is NO_SHARE LIBRARY DATA (The default.) At
runtime, Form Builder will not share data between forms that have identical libraries attached (at design
time).

QUESTION NO: 62
How can you change the cursor style in your form?

A. Open the form module property palette and set the Cursor Style property.
B. From the Tools menu, select Preferences-->Runtime Settings.
C. Use the GET _APPLICATION PROPERTY and SET APPLICATION PROPERTY built-ins.

D. You cannot change the cursor style.

Answer: C

Explanation : GET _APPLICATION PROPERTY and SET _APPLICATION PROPERTY built-ins are
used to Get and Set properties of the form applications. CURSOR_STYLE parameter Returns the name of
the current cursor style property.

QUESTION NO: 63
Which trigger property applies to Key triggers?

Hide Keys

Show Menu Keys

Hide Menu Keys

Display in ‘Keyboard Help’
Hide Keys Description

moQwx

Answer: D

Explanation : Key triggers allow you to modify the standard functionality of a function key. These triggers
are subprograms that execute when a certain key is pressed. Key triggers allow you to modify, replace, or
disable the standard functionality of a function key. Display in ‘Keyboard Help’ can be an application of key
trigger.

QUESTION NO: 64
Which two statements are true about record groups? (Choose two)
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They are stored in the database.

They are stored in local Forms memory.

The type is specified explicitly at design time.
The type is implied by when and how it is created.

oCOowpx>

Answer: B, D

Explanation : When record groups are created they will be stored in the local forms memory where they
created. Record group can be created from a query with CREATE_ GROUP_FROM_QUERY or created
manually using CREATE GROUP the type is implied by when and how it is created.

QUESTION NO: 65

You need to change the text of a pop-up menu that appears when a user right clicks the mouse in the
EMP_DATA data block. Where could you find the node for the pop-up menu in the Object
Navigator?

Built-in Packages
Menus

PL/SQL Libraries
Object Libraries
Form Module

moNwp»>

Answer: E

Explanation : Pop-up menus can be created in a form module. It must be attached to an item or canvas of a
form. The user can click the right mouse button to invoke the pop-up menu when the mouse is on the item or
canvas.

QUESTION NO: 66
Which built-in would you use to test whether the CREATE TABLE command issued in the SALES
form executed successfully?

FORMS DDL
DO SQL
FORM_SUCCESS
FORM_NOT SUCCESS
DBMS.ERROR_CODE

moONwx

Answer: C
Explanation : FORM_SUCCESS Returns the outcome of the action most recently performed during the
current Runform session.

Outcome Returned Value
success TRUE

failure FALSE

fatal error FALSE
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QUESTION NO: 67

Examine the code below:

FUNCTION check_window RETURN VARCHAR2 IS

BEGIN
RETURN (GET_VIEW_PROPERTY (GET_ITEM_PROPERTY (
NAME IN(‘system.cursor _item’), item canvas),
window_name)) ;

END;

What does this function return?

The name of the item where the cursor is located.
The name of the form where the cursor is located.
The name of the window where the cursor is located.
The name of the canvas where the cursor is located.

oOwy

Answer: C

Explanation : The GET ITEM_ PROPERTY is used to retrieve property of a specific item.
ITEM_CANVAS parameter Returns the name of the canvas to which the item is assigned. When used with
GET VIEW_PROPERTY which retrieve a property for specific view it will return the name of the window
where the cursor is located since system.cursor_item is used in the GET ITEM_ PROPERTY.

QUESTION NO: 68
You are developing a Hotel Booking application for a travel company. The users request a wizard-
style interface for this application. How could you satisfy this requirement?

Reference the Object Iron packages in your form module.

Write an HTML interface, and invoke it from your form module.

Include the Wizard class reusable component in your application.

Build a customized wizard using tab canvases and a horizontal toolbar canvas.

oCawx>

Answer: C

Explanation : The Wizard class reusable component allows you to add a wizard-style interface to your
application. This type of interface is similar to the wizards found in Oracle Developer builders. Creating an
interface to step a customer through the playset building process is an ideal use of this component. This
component is found in the stndrd20.olb library. You could build this wizard-style interface by using tab and
horizontal toolbar canvases and writing the necessary code, but this would take much longer than using the
Wizard class.

QUESTION NO: 69
Which statement about windows and blocks is true?

Leading the way in IT testing and certification tools, www.testking.com

-29.-



1z0-132

Transaction management is block-oriented rather than window-oriented.

Forms automatically navigates to an item located in an activated window.

A window may contain multiple blocks, but each block can only span one window.

A window can contain multiple canvases, and an item can be located on multiple canvases.

oCOowpx>

Answer: A

Explanation : Transaction management in Oracle Forms is block based. Commit processing takes place in
the block sequential order. Each item of a block may be assigned to a canvas and each canvas is assigned to
a window. Therefore, a block can be displayed in multiple windows.

QUESTION NO: 70
What does the following code do?
BEGIN
IF GET_RECORD_PROPERTY (3, ‘ORD’, status) = ‘CHANGED’ THEN
SET_RECORD_PROPERTY (3, ‘ORD’, status, query status);
END IF;
END;

If the third property in the ORD block is changed, set the status back to QUERY.

If the third record in the current block is set to ORD, set the status back to QUERY.

If three records are changed database records in the ORD block, set the status back to QUERY.
If the third record in the ORD block is changed database record, set the status back to QUERY.

SRl s

Answer: D

Explanation : SET RECORD PROPERTY Sets the specified record property to the specified value.
QUERY_STATUS Specifies that the record is to be treated as a QUERY record, whether it actually is. The
syntax is :

SET RECORD PROPERTY
( record number NUMBER ,
block name VARCHAR?2,
property NUMBER,

value NUMBER);

So If the third record in the ORD block is changed database record, set the status back to QUERY.

QUESTION NO: 71
The data blocks in your form module are based on object tables. How would you create a master-
detail relationship between two of these blocks?

A. Use the Data Block Wizard and base the relation on a REF pointer.

B. In the Object Navigator, select the Relation node under the master block and click the Create icon.
Build the relation manually and coordinate the blocks using triggers.
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C. Use the Data Block Wizard, and base the relation on the primary key-foreign key relationship in the
database.

D. This task is not possible because master-detail relations can be implemented only for blocks based on
relational tables.

Answer: A

Explanation : when you want to coordinate the two blocks using a REF. You have already created the
master block and the detail block. Next, you should click the Create Relationship button in the Data Block
Wizard. This will open the Relation type dialog box and allow you an option of creating the relation using a
REF instead of a foreign key.

QUESTION NO: 72
Which built-in copies values from a list item into a record group?

RETRIEVE_LIST
RETRIEVE_GROUP
RETRIEVE_LIST ITEM
RETRIEVE_GROUP_FROM LIST
RETRIEVE GROUP_FROM _LIST ITEM

mo 0wy

Answer: A

Explanation : The RETRIEVE_ LIST built-in retrieves and stores the contents of the specified list item into
the specified record group.

Example:

DECLARE

MyRecord RECORDGROUP;

FirstColumn RECORDCOLUMN,;

SecondColumn RECORDCOLUMN;

BEGIN

MyRecord := CREATE _GROUP ('ratings_rg'");

FirstColumn := ADD_GROUP_COLUMN (rg_id,'label',character column);
SecondColumn := ADD GROUP_COLUMN (rg_id,'rating',character column);
RETRIEVE LIST (‘customer ratings_list', MyRecord);

END;

QUESTION NO: 73

The telesales force requested additional ways to terminate the automated polling questionnaire. In
addition to the default functionality, you provide a menu item and a button for this purpose. Adhering
to efficient coding practices, which PL/SQL code do you use for the menu item and the button?

EXIT;

EXIT FORM;

DO KEY (‘Key-Exit’);
DO_KEY (‘EXIT FORM’) ;

COowp

Leading the way in IT testing and certification tools, www.testking.com

-31 -



1z0-132

Answer: D

Explanation : The DO_KEY built-in function executes the key trigger associated with the built-in that is
specified as its parameter. If no associated key trigger exists, then the specified built-in subprogram
executes. For example, DO_KEY('EXIT_FORM'), when executed, will search for a Key-Exit trigger. If it
does not find a Key-Exit trigger, it will execute the EXIT FORM built-in.

QUESTION NO: 74

You create a master-detail form. The users need to be able to exit the form quickly, adhering to
default transaction processing, regardless of the cursor location. You believe you can achieve this
using a Key-Exit trigger.

What do you need to do to implement this request?

A. Define a Key-Exit trigger for all the blocks in the form.

B. In the Object Navigator, highlight all the items and define a Key-Exit trigger.
C. Define a Key-Exit trigger on the primary key item in the master block.

D. No additional key-trigger definition is necessary.

Answer: D

Explanation : Creating a When-Button-Pressed trigger including the EXIT FORM built-in would not
execute the customized code found in the Key-Exit trigger. However, a When-Button-Pressed trigger with
DO KEY(EXIT FORM') would execute the Key-Exit trigger, if one exists. No need for additional key-
trigger definition is necessary.

QUESTION NO: 75
Which is an example of a dynamic SELECT statement?

A query whose object names change during its execution.

A query whose object names are not known until run time.

A query whose bind variables values change during execution.

A query whose bind variable values are not known until run time.

Cawp>

Answer: B

Explanation : When the select statement queries database with objects specified at run time it’s considered
to be a dynamic SELECT statement. Object names will specified at run time. FORM_DDL executes queries
for the form that will specify object names at run time. FORM_DLL can construct dynamic query.

QUESTION NO: 76
Which datatype is returned by the FIND_MENU_ITEM built-in function?

A. number

B. Boolean
C. menuitem
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D. VARCHAR2

Answer: C
Explanation : FIND MENU ITEM Searches the list of menu items and returns a menu item ID when it
finds a valid menu item with the given name.

QUESTION NO: 77

In the COURSE_ENROLLMENT form module, you define a master-detail relation between the
COURSES _OFFERED data block and the STUDENT data block, respectively.

To implement block coordination, which statement must be true?

A. The Enforce Primary Key property on the STUDENT block is set to Yes.

B. The Alias property on the COURSES OFFERED block is set to Student.

C. The Copy Value from item property on the foreign key item in the STUDENT blocks is set to the
primary key item of the COURSES OFFERED block.

D. The Synchronize with item property on the foreign key item in the STUDENT block is set to the
primary key item of the COURSES OFFERED block.

Answer: C

Explanation : Synchronize with item property Specifies the name of the item from which the current item
should derive its value. Setting this property synchronizes the values of the two items, so that they
effectively mirror each other. When the end user or the application changes the value of either item, the
value of the other item changes also. This property is used when you define master-detail relationship
between two blocks.

QUESTION NO: 78
You write a procedure that will be called from two level triggers and a database trigger.
Where should you store this code?

On the Oracle server.

Locally in each form module.
In an attached PL/SQL library
On your file network server.

Cawp>

Answer: A

Explanation : Stored Procedures are stored in Oracle Server. These stored procedures can be called by the
form applications and from the triggers specified in Forms. Stored procedure can be called also from
database triggers. Database triggers can not call libraries stored in Forms at the client applications.

QUESTION NO: 79
You need to create a data block for query operations in the RETIRED EMPLOYEES form module.

Which three data sources can you use for this block? (Choose three)

A. vector
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database view

database table
transactional trigger
PL/SQL table of records
multi-dimensional array

mmoaw

Answer: B, C, D

Explanation : A data block can be based on a relational table, Database view, an object table that is based
on a single object type, and a relational table that uses a REF column. It cannot be based on a varray column,
a stored procedure that returns an object value, and object tables that are based on a complex type.
transactional triggers are typically used when Form Builder is running against a non-ORACLE data source.
These triggers include ON-FETCH, ON-LOCK, ON-ROLLBACK.

QUESTION NO: 80
Which two PL/SQLS features are supported in Oracle Forms? (Choose two)

methods

object tables

object columns

collection types

object as stored procedure parameters

moQwy

Answer: B, C

Explanation : Blocks can be based on object tables and items can be based on object columns within Oracle
Forms. Oracle Forms also supports declaration of LOB variables. However, Oracle Forms does not support
the declaration of collection variables. It also does not support objects as stored procedure parameters.

QUESTION NO: 81
What is the data type returned by the CREATE_TIMER built-in?

long
timer
number
varchar?

oCOw>

Answer: B
Explanation : The CREATE TIMER built-in returns the internal ID of the timer. Therefore, the V. TIMER
variable must be declared with a datatype of TIMER.

QUESTION NO: 82

You have written a custom menu for a Forms application. You saved the menu module to the file
custmenu.mmb. In the Property Palette for the form, you set the Menu Module property to custmenu.
When you run the form, the custom menu does not appear.
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What can you do to fix this problem?

Generate the menu module executable.

Save the menu module as custmenu.mmx.

In the Property Sheet for the form, set the Starting Menu property to custmenu.

In the Property Sheet for the form, set the Menu Module property to custmenu.mmb.

SOowpx>

Answer: A

Explanation : An Oracle Developer menu module must be compiled to create the executable file (MMX).
This file must be attached to a form application.

Select File-->Administration-->Compile File to compile a menu. To attach the menu module to a form,
navigate to the form module property sheet and locate the Menu Module property. Specify the name of the
menu in this property.

QUESTION NO: 83

You want to make use of the object features available in the database for the form module you are
developing.

Which three statements about object types are true? (Choose three)

An object type is a user-defined composite data type.

The attributes of an object type can be those of other object types.

A PL/SQL table of records is an example of a nested object type.

An object type must be declared as a type before the actual object itself can be declared.

COowp>

Answer: A, B, D

Explanation : Object types is a user-defined composite data type and each attribute of an object type can be
an object type of other types specified. But object types must be declared first as type before they are
declared in other object types.

Example:

CREATE OR REPLACE TYPE name_typ AS OBJECT
(f name VARCHAR2(25),

1 name VARCHAR2(25),

initials VARCHAR2(7));

CREATE TABLE name_table OF name _typ;

QUESTION NO: 84

What are three uses for record groups? (Choose three)
A. To pass data to a pop-up menu.

B. To populate a base table block.
C. To pass data to other form modules.
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D. To pass data to other Oracle products.
E. To dynamically construct SELECT statements.
F. To server as the source for a FROM clause query.

Answer: C,D, E

Explanation : Regardless of how a record group is created, it can be used to send information to another
form or Oracle Developer product such as Reports and Graphics. The SELECT statement can be built during
runtime and used for a programmatically created record group or design time record group. Record groups
can be populated using the POPULATE _GROUP_ WITH QUERY built-in. Record groups cannot be used
as a source for a data block, menu item, or FROM clause query.

QUESTION NO: 85
Which scenario describes an appropriate use for opening a form in a new session?

The data entered into the called form is logically independent of the data entered in the calling form.
The called form requires different privileges than the calling form.

The called form must execute as a different user than the calling form.

The calling form must be able to query data in the called form before it is saved.

oOwp

Answer: A

Explanation: OPEN_FORM and CALL FORM are built-ins that can invoke a form. Only the
OPEN_FORM built-in can invoke a form using a new database session by using the SESSION. MODE
parameter. For example:

OPEN_FORM ('customer', ACTIVATE,SESSION);

The SESSION keyword instructs Forms to open the CUSTOMER form with a new session. Therefore, DML
operations performed in the CUSTOMER form will be part of a separate transaction. Committing in the
CUSTOMER form will not affect the transaction in the ORDER form.

QUESTION NO: 86
You create a multiple form application- Which built-in must you use to invoke the form modules to
enable you to programmatically control navigation between the multiple forms in your application?

A. NEW_FORM

B. OPEN FORM
C. CALL FORM
D. CLOSE_FORM

Answer: B
Explanation: Because OPEN_FORM opens forms as modeless windows, users can switch freely to
different open forms. Therefore, it is most appropriate for invoking forms from the application-system
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menu. However, a disadvantage of using OPEN_FORM is that it is hard to keep multiple open forms
synchronized.

QUESTION NO: 87

You are creating the SAL_INFO data block on the EMP_QUERY form. The SALARY field should
only be populated if the logged-on user is a manager. Since this query could potentially return a large
amount of records, you have created a stored procedure which uses a ref cursor on which to base the
data block.

How would you create the data block?

A. Click the Data Blocks node in the Object Navigator and click the create button.
Choose to build the data block manually.
Enter the procedure name in the Query Data Source Columns property and the procedure code in the
Query Data Source Arguments property.

B. Choose Tools -> Data Block Wizard, select Table as the data source type, and base the data block on
the columns included in the procedure.

C. Select the Data Blocks node in the Object Navigator and click the Create button.
Choose to build the data block manually, alter the Query Data Source Type property to ‘Ref cursor’,
and enter the name of the procedure in the Query Data Source Name property.

D. Select the Data Blocks node in the Object Navigator and click the Create button.
Alter the Query Data Source Name, Query Data Source Columns, and Query Data Source
Arguments properties to create a stored procedure that uses a ref cursor.

E. Launch the Data Block Wizard, select Stored Procedures as the data source type, and base the block
on the procedure.

Answer: E

Explanation: Data block can be based on stored procedure that uses REF cursors. Basing data blocks on
such procedures can be done using the Data Block Wizard. Select Stored Procedures as the data type of the
data block.

QUESTION NO: 88

You want the user to toggle between two states of a check box in the SALES data block. When the box
is checked the value is ‘True’ and if it is unchecked the value is ‘False’. Which built-in could you use
in a When-Checkbox-Changed trigger to obtain the current master/detail query behavior?

GET BLOCK_PROPERTY
GET_RELATION PROPERTY
SET RELATION PROPERTY
WHEN_MOUSE CLICK

LIST VALUES

mo 0w

Answer: A
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Explanation: GET BLOCK PROPERTY Returns information about a specified block.
COORDINATION_STATUS parameter For a block that is a detail block in a master-detail block relation,
this property specifies the coordination status of the block with respect to its master block(s). Returns the
VARCHAR?2 value COORDINATED if the block is coordinated with all of its master blocks. If it is not
coordinated with all of its master blocks, the built-in returns the VARCHAR?2 value ON_ COORDINATED.
Immediately after records are fetched to the detail block, the status of the detail block is COORDINATED.

QUESTION NO: 89
Which three values are valid parameters for the DO_KEY built-in? (Choose three)

ENTER
GO ITEM
VALIDATE

EXIT FORM
EXECUTE _QUERY

moONwy

Answer: A, D, E

Explanation: The DO_KEY built-in function executes the key trigger associated with the built-in that is
specified as its parameter. If no such key trigger exists, then the specified subprogram executes. The
parameter must be a built-in that is associated with a key trigger. VALIDATE GO_ITEM are not a built-in
that can be executed by the default action of a key.

QUESTION NO: 90
You need to create a trigger to locate the Product report in the Rpt Server, run the report, and test
the status of the report. Which three built-ins would you use to accomplish this task? (Choose three)

RUN_PRODUCT
SET REPORT OBJECT PROPERTY
RUN_REPORT OBJECT

FIND _REPORT OBJECT

REPORT OBJECT_STATUS

COPY REPORT OBJECT OUTPUT

mmoawy

Answer: C,D, E

Explanation:

RUN_REPORT_OBIJECT built-in Use this built-in to run a report from within a form. You can run the
report against either a local or

remote database server. Executing this built-in is similar using the RUN PRODUCT built-in on a report.

FIND REPORT OBIJECT built-in Returns the report_id for a specified report. You can use this ID as a

parameter for other built-ins, such
as RUN_REPORT OBIJECT .
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REPORT OBJECT STATUS built-in Provides status of a report object run within a form by the
RUN_REPORT OBJECT built-in.

QUESTION NO: 91
Which two statements are true about mouse button variables? (Choose two)

SYSTEM.MOUSE BUTTON_PRESSED returns a string.

SYSTEM.MOUSE BUTTON_PRESSED returns a numeric value.

A possible value for SYSTEM.MOUSE BUTTON_ MODIFIERS is Control+Alt+Delete.
SYSTEM.MOUSE BUTTON_ MODIFIERS can only be references in form-level triggers.
SYSTEM.MOUSE BUTTON_MODIFIERS identifies which special key was pressed in conjunction
with the usual mouse button action.

SESRo- IS

Answer: B, E

Explanation: SYSTEM.MOUSE BUTTON_ PRESSED indicates the number of the button that was
clicked, either 1, 2, or 3 (left, middle, or right). The value is always a character string.
SYSTEM.MOUSE BUTTON_MODIFIERS indicates the keys that were pressed during the click, such
as SHIFT, ALT, or CONTROL. The value is always a character string.

QUESTION NO: 92

You have a master-detail relationship in the EMPLOYEE form module. You set the Delete Record
Behavior property to Cascading. When a user deletes a master record, how does Forms implement the
cascade-delete foreign-key rule?

With a Pre-Delete trigger.

With an On-Delete trigger.

With a Post-Delete trigger.

With the On-Check-Delete-Master trigger.

oOwp

Answer: A

Explanation: The Pre-Delete trigger Manipulate a record prior to its being deleted from the database during
the default Post and Commit Transactions process; for example, to prevent deletion of the record if certain
conditions exist.

QUESTION NO: 93

What is the use for the SET_TIMER built-in?

Retrieve the timer ID.

Change the timer name programmatically.

Determine what to do upon timer expiration.

Set the repeat behavior without changing the time interval.

oOwp

Answer: D
Explanation: Timers can be modified using the SET TIMER built-in.
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Syntax:
SET TIMER ('timer name', milliseconds, iterate);

To keep a previously specified parameter value, you can specify NO_CHANGE.

QUESTION NO: 94
What are three characteristics of the CALL_FORM built-in? (Choose three)

A. It is an unrestricted procedure-

It is valid in Enter Query mode.

It invokes a form in a modal window.

It can only invoke a form in Query Only mode.

It enables you to start a new database session.

It enables free navigation between all opened form sin an application.

mmoaw

Answer: A, B, C
Explanation: The CALL FORM built-in invokes a specified form as a modal window. It is unrestricted and
can be executed during Enter Query mode.

Example:
CALL FORM('customer');

QUESTION NO: 95

You want to provide a tool that allows users quick access to form modules, by listing them in an
Explorer-style interface.

Which reusable component do you use?

ActiveX controls
Calendar Class
Standard Object Library
Picklist Class

Wizard Class

Navigator Class

mmoOw»

Answer: F

Explanation: The Navigator class reusable component allows you to add an Explorer-style interface to your
application. This type of interface is similar to the Object Navigator of the Oracle Developer builders. This
component is found in the stndrd20.olb library.

QUESTION NO: 96
The users request that [F2], [F3], and [F4] be used to commit, rollback, and exit, respectively.
How do you accomplish this?
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Add the appropriate PL/SQL code for each key.

Map the logical keys to the physical keys, then add the appropriate PL/SQL code for each key.
Create an object library to define the key triggers, then reference the object library in the form.
This cannot be accomplished because other function keys provide this functionality by default.

oCOowpx>

Answer: B
Explanation: Each local key should be mapped first to physical key. Then PL/SQL code can be add for
each key to make function keys act as commit, rollback and exit actions.

QUESTION NO: 97
At design time, you create a query record group for the LOV associated with the HOTEL text item in
a form module for the Travel Planner Application. When is the record group populated?

A. When the user navigates to the HOTEL item.

B. When the form module successfully compiles.

C. After Form Builder validates the SELECT statement and dismisses the New Record Group dialog
box.

D. When the user enters data in the HOTEL item, and the Validate from List property for the HOTEL
item is set to YES.

Answer: D
Explanation: When record group is used in a LOV for a text item, The record group is populated when the
user enters data in the text item and the Validate From List property of the text item is set to YES.

QUESTION NO: 98
Examine this code:
BEGIN
IF :SYSTEM.EVENT WINDOW = ‘WELCOME’ THEN
DO_KEY (‘exit form’);
ELSE MESSAGE (‘Illegal operation’);
END IF;
END;

In which form level trigger would you implement this?

When-Window-Closed
When-Window-Changed
When-Window-Resized
When-Window-Activated

Caowp>

Answer: A
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Explanation: The code I[F :SYSTEM.EVENT WINDOW = ‘WELCOME’ will check for active window
name. DO _KEY(‘exit form’) will exit the form, This code can be called to check the name of the window
which is about to close. It should be placed in When-Window-Closed form trigger.
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Section B — less important questions
Study these questions as well.

QUESTION NO: 1
You want to create a template to be used as a standard for all company reports, which are many
different styles. How many different templates must you have if you plan to use multiple report styles?

Two

One

One per report style.

One per report style + one more

COowpx>

Answer: B

QUESTION NO: 2

You create a salary report to display employee salaries grouped by the dept column. You need to
change the break order from ascending to descending using the model. How would you reverse the
display order of the department?

A. Double click the dept column in the group to alter the property palette and change the break out order
value.

B. Double click the dept column in the group to open the property palette and change the set break order
value.

C. Double click the g_dept group object to change the break order.

D. Click the dept column in the group to change the break order.

Answer: A

QUESTION NO: 3

Using the report wizard you create a tabular report to display all the columns in the EMP table. The
records are ordered by the dept_name and job columns. You need to create a hierarchical report that
breaks on the dept_name and job values. Using the data model how would you create this break
structure?

A. Specify the break order on the g emp group Property palette.

B. Specify a break order on the dept name and job columns property palettes.

C. Click and drag the dept_name and jobs column out and above of the g emp group to create a new
parent group.

D. Change the position of the dept_name and the job columns within the g _emp group.
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Answer: C

QUESTION NO: 4

A few months ago, you created a sales transaction report using this query:
SELECT sales_ID, transaction number, amount

D. FROM sales

WHERE sales_date=trunk(sys date)

Today you need to modify the report to include each transactions % of totally daily transactions. How
can you accomplish this task?

A. In the date model add a summary column to the group to give up % of a total of the amount column.

B. In the data model add a place holder column to the group to give a % of total of the amount column.

C. In the data model add a summary column outside the group to give a % of total of the amount
column.

D. In the data model add a place holder column outside the group to give a % of total of the amount
column.

E. In the layout model add a final in the field in the repeating group to calculate a % of the total of the
amount column.

Answer: A

QUESTION NO: 5
How are messages displayed when you use the SRW.MESSAGE packaged procedure?

Dialogue box that implicitly determines report execution.
Message line that implicitly determines report execution.
Message line that suppresses the default oracle message.
Dialogue box that does not terminate report execution.
Dialogue box that suppresses the default oracle message.

moONwy

Answer: D

QUESTION NO: 6

You created a tabular report for human resources department. After viewing layout users have
requested that you change the label of the dept column to something more meaningful. How would
you change the label in the live previewer?
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Use the report wizard to change the column label.

Click and high light the column label and replace it with desired text.
Click the column label and alter its property palette.

Click the dept column and alter its property palette.

oCOowpx>

Answer: B

QUESTION NO: 7

You created a department report and preview it in life preview. The font for the department name is
too small and you want to enlarge it but do not want to change the font for any other fields. What is
the easiest way to make this change?

Select the text to be enlarged in the life previewer and make the size change using the style bar.
Select the text to be enlarged in the layout mode and make the change.

Open the report wizard in the re-entrant mode and make the change.

Make the copy of the report, open the copy, make the changes and then delete the original report.

oOwp

Answer: A

QUESTION NO: 8

Your company has implemented the report’s server three-tier architecture. From 4 to 5 P.M each day
several departments begin running their daily reports. Which tier of this architecture will spawn
extra run time engines to process the increased activity?

Client

Application

Database server.

These extra run time engines are not automatically created they must be initiated by the users
executing the report.

oOwp

Answer: B

QUESTION NO: 9

You created a tabular report for the sales department to display each customer and the sales person
assign to the customer. The data is sorted by customer using the order by clause in this query. This is
department manager asks you to alter the report so that data is sorted by sales person rather than by
customer. What is the best way to make the needed change?

A. Recreate the query and default the layout.
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B. Alter the query, default the layout and redo the boiler plates.
C. Query and manually change the layout to save the boiler plate.
D. Alter the query and make no further change.

Answer: D

QUESTION NO: 10

The CALC function is used several times within the sales report. To simplify maintenance you want to
store the function in one place and call it from within your PL/SQL trigger code. Which node would
you use in object navigator to create a report level programme unit to store the function?

A. Programme units.
B. PL/SQL libraries.
C. Database object.
D. Built in packages.

Answer: A

QUESTION NO: 11

You are developing an inventory report to list the item number, description price and picture of all
inventory items. The layout of each item is a repeating frame that contains three fixed fields and a
image. When possible you want all objects in the repeating frame to appear on the same logical page
without creating blank pages between instances. Which pagination property would you alter to
achieve these results?

Page break before.

Page break after.

Page protect.

Keep with anchoring object.

Cawp>

Answer: C

QUESTION NO: 12
You are creating a report containing two headers and three tailor pages. You set the logical page size
to 2 into 1. The body if the report is four logical pages. How many physical pages is the entire report?

A. 36

B. 4
C. 9
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Answer: D

QUESTION NO: 13

The IT department requested a report to list each server name and the name of each department that
utilizes resources from each server. You create a tabular layout that breaks on the server name. You
ran the report and noticed that the department field is too large for most of the department names.
Which field size setting would you use to allow the field to be smaller but not larger than the field
layout size?

Fixed
Expand
Contract
Variable

oOwp

Answer: C

QUESTION NO: 14

The IT department is creating a human resources application that will require several new tables.
You need to develop a standard alone executable that will defines these tables and their relationships.
Which developer/2000 component could you use to create the executable?

Procedure builder.
Query builder.
Schema builder.
Form builder.

Project builder.
Transactional builder.

mmoaw»>

Answer: C

QUESTION NO: 15
You want to create a template to be used as a standard for all company reports. What is the easiest
way to do this?

A. Open an existing template file, rename it and modify the template objects.

B. Open the report wizard and create a new template.

C. Open the layout model and copy the paste items from the default templates provided in report
builder.
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D. Templates cannot be modified in release 2.

Answer: A

QUESTION NO: 16

In the data model you created two queries that produced two groups named employee and sales. The
sales group is a child in the employee group. You establish a relationship between the two queries by
creating a link. Which modifications would you make to the data link property sheet for this
relationship?

No modifications are needed because the default values represent the relationship.
Modify the SQL clause to having and conditioned to like.

Modify the SQL clause to where and condition to like.

Modify the SQL clause to having and condition to =.

ocaowp

Answer: A

QUESTION NO: 17
The sales report needs to display the sales person with the highest order total. Which build report
builder component would you use to create a place holder column to display the value?

A. Report wizard.
B. Layout model.
C. Data model.

D. Life previewer.

Answer: C

QUESTION NO: 18

The accounts receivable department requested an accounts status to allow users to enter either a
customer name, customer number, customer phone number and then display the customer out
standing balance. You want to restrict the data retrieved based on values entered by the users. Which
where clause would you write in the query to select statement to accomplish this task?

A. &p where clause

B. :p_where clause

C. WHERE CUST ID=P_CUST ID or cust name=:p_cust name or cust phone=:p cust phone
D. Where cust_ID=&p_custid cust name=&p_cust name or cust_phone=&p_cust phone
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Answer: A

QUESTION NO: 19

The order entry department requested a report to display the average time to enter an order from
each order entry clerk sorted by supervisor with a group average after viewing the report users
requested to bold the value for each supervisors group average. Where would you make this change?

In the template used.

In the data model.

In the life previewer.

In the field property palette.

oCOowp>

Answer: C

QUESTION NO: 20

You created a report from the human resources department based on all the columns in the EMP
table. After viewing the report users requested that the cmp ID columns peers first in the output.
How would you change the position of the column?

After the query.

Enter the report and change the column’s position in the field tab.

Alter the column’s position in the object navigator.

Enter the report wizard and change the column’s position in the data tab.
Alter the column’s position within its group and change the layout.

moONwy»

Answer: B

QUESTION NO: 21

The human resources department requested an employee report to high light those employees who are
due for 30 days 6 months and 1 year evaluation. The higher data field should display blue text for 30
days employee, a red text for 6 months employees and a green text for one year employees. You
created a format trigger on the higher_data field to handle this task. What will happen if the format
trigger returns a false value?

The report execution will be halted.

The higher data file will not be displayed.
The record will not be displayed.

Nothing will happen.

oSOowp>

Leading the way in IT testing and certification tools, www.testking.com

- 49 -



1z0-132

Answer: B

QUESTION NO: 22
Which tool in the layout model could you use to create an external boiler plate object?

Field
Frame
Button
Rectangle
Link file

moQwy»

Answer: E

QUESTION NO: 23

You are developing a report to allow customers in a department store to view product information.
You added a button to the layout to allow customers to view the picture of the product. Which button
property would you alter to specify the source of the .BMP file?

Type

Multimedia file
Multi media file type
Label type

oCOowpx>

Answer: B

QUESTION NO: 24

You are creating a tabular report for the sales department with a department break group. You need
to ensure that if al least six sales records will not fit at the button of a page, the group will start on the
next page.

Which printing frame property would you alter to achieve these results?

Source

Print direction

Maximum records per page
Minimum Widow records
Column mode

monQwx

Answer: D
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QUESTION NO: 25

The registrar’s office requested a report that lists each students, their advisors name and phone
number. Each class has currently enrolled in and a great point average for each semester. To do this
you need to pull data from the student, advisor, class and grade tables. From a performance point of
view which data model options is preferable for data base access?

Create one query and three additional groups.

Create two query and two additional groups and then relate the groups.
Create three queries and one additional group and then relate the groups.
Create four queries and relate the groups.

Cawx>

Answer: A

QUESTION NO: 26

In the data model you created this query:

SELECT ID_no, description, price, quantity, manufacturer_ID
FROM inventory

Next you click and drag the manufacturer_ID column out of and above the default group. You needed
to sort the child group by ID_number. How could you accomplish this task?

Add an order by clause to the query.

In the data model double click the ID_number column and alter the break order.

In the layout model double click the ID_number filed and later the print direction.

Default the layout, choose a master/detail report style and select ID_number as the break order.

oOwp

Answer: A

QUESTION NO: 27

The accounts receivable department requested a report with five columns of data several text fields
and a graphic to be used as a customer invoice. After viewing the report users realize that one of the
columns contains a redund data in the interest of performance. You want to remove the
corresponding data base column from the report. How would this be accomplished without altering
the text and graphics in the body of the layout?

Remove the column from the select statement.

Delete the field from the layout.

Remove the column from the select statement and default the layout.

Remove the column from the select statement and delete the field from the layout.

oCOow>

Leading the way in IT testing and certification tools, www.testking.com

-5] -



1z0-132

Answer: D

QUESTION NO: 28

You created an out standing accounts report for the accounts receivable department you saved the file
to the database as a R10971. To adhere to your company’s naming standard. Since the naming
standard creates very simple report name your end user are often unsure that if they ran the right
report. Which window could you use to overwrite the report title so that for the users it displays as out
standing accounts?

Tools (arrow sign) preference.
Parameter form editor.
Layout model.

Report properties.

oSaowx>

Answer: D

QUESTION NO: 29
The character mode sales report is stored on the network drive as a .REX. You need to make changes
to the report layout. Using the report builder how would you change this file?

A. Open the file using the menu option file->open make the changes and recompile the report.

B. Convert the file into .REP file using the report compiler make the changes and convert the file back
to a .REX file.

C. Execute the R30CONV command to convert the file to a .RDF file, make the changes and convert
the file back to a .REX file.

D. Choose file -> administration->compile.
Convert the file to a .REP file, make the changes and convert the file back to a .REX file.

E. Execute the R30CONYV command to convert the file to a .REP file, make the changes and convert
the file back to a .REX file.

Answer: D

QUESTION NO: 30
Which report style would you use to create a report listing each department and including a listing of
employees beneath their respective department?

A. Group left.

B. Form like.
C. Matrix W/group.
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D. Group above.
E. Mailing label.
F. Form letter.

Answer: D

QUESTION NO: 31

Human resources department requested a report to display the total number of employees working in
each department. To begin you created this query:

SELECT dept_ID, count (employee_id)

FROM employee

C. GROUP BY dept_ID

You defaulted the layout and choose a tabular report style. In the layout model which property sheet
would you alter to restrict the number of records appearing on each page?

Frame

Report

Field

Repeating frame

SRl s

Answer: D

QUESTION NO: 32
When is an implicit anchor created?

When an object is enclosed by another object.

When a page break after pagination property is enabled.

When a link is created between two objects.

When a keep with anchoring object pagination property is enabled.

Caowp>

Answer: A

QUESTION NO: 33
Which statement is true about mouse events?

A. The cursor style can be set to CAUTION.

B. Double-clicking a mouse button can potentially fire six mouse event triggers.
C. The values for the SYSTEM.MOUSE BUTTON_PRESSED system variable can only be 1 or 2.
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D. Click and double-click button actions can only detect if the mouse is positioned in an item.

Answer: B

QUESTION NO: 34

You are creating the DEPT_SAL data block from the PAYHIST form. Users should be able to enter a
valid department ID number, which will then display the employee salary information for that
department. This data block could potentially retrieve a large number of records. Since users will
probably only view a small number of these records, only 10 records should be fetched at one time.
How would you create the data block?

A. Select The Data Blocks node in the Object Navigator and click the Create button.
Choose to build the data block manually, enter the procedure name in the Query Data Source
Columns property, and the procedure code in the Query Data Source Arguments property.

B. Choose Tools -> Data Block Wizard, select Table as the data source type, and base the block on the
columns from the tables.

C. Choose Tools -> Data Block Wizard, select, View as the data source type, and base the block on the
columns from the tables.

D. Select the Data Blocks node in the Object Navigator and click the Create button.
Choose to build the data block manually, alter the Query Data Source Type property to ‘FROM
clause query’, and enter the SELECT statement in the Query Data Source Name property.

E. Select the Data Block node in the Object Navigator and click the Create button.
Alter the Query Data Source Type, Query Data Source Name, Query Data Sources Columns, and
Query Data Source Arguments properties to create a stored procedure that uses a red cursor.

Answer: E

QUESTION NO: 35

The manager of the sales department requested all the sales data report execute daily 5 P.M. The
result should be sent to her via e-mail. Which destination type would you use to send the output using
your company’s MAPI-compliant system?

A. Screen

Preview

File

Printer

E-mail

The destination type depends on how the manager prevents to preview the result.

mEoOOw

Answer: E
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QUESTION NO: 36

You are creating a report wizard to create a matrix report. The query build, you select the

patient name column from the patient table; the doctor_name from the doctors table; and the
doctor_ID, patient ID and ID columns from the procedure table. In the report wizard you select
patient_name as the row value, doctor_ID as the column values and the count as the cell values. You
need to add a total for each doctors column. In the wizard report which tab will allow you to create
the summary column?

Rows
Totals
Columns
Cells
Data

mUO0wp

Answer: B

QUESTION NO: 37
How would you default the layout of a parameter form?

Use the default layout tool in the parameter form editor.

Select menu item tool->parameter form builder.

Open the parameter form editor and select menu items tool->default layout.
You cannot default the layout of the parameters.

oSOowp>

Answer: B

QUESTION NO: 38
Using the reports server how would you force the orders report in the orders entry application to run
every six hours?

Schedule the report’s execution in the queue manager.

Schedule the reports execution using the R30RQM command line with scheduled parameter.
Create a trigger in the application to execute the report every six hours.

You cannot schedule a reports execution.

oOwp

Answer: A
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QUESTION NO: 39

You are developing a bonus report for the payroll application to calculate and display the bonus issue
to each envelope. Employees with a salary of less than 500008 earn a bonus of 15% and the employees
who earn 500008 or more earn out 10% bonus. Which type of trigger would you use to conditionally
assign a bonus percentage?

Report level trigger.
Group filter.
Format trigger.
None of the above.

Sawp>

Answer: D

QUESTION NO: 40

A human resources department requested a report to show the total number of employees working in
each department. To begin you created this query:

SELECT detp_ID, count (employee ID)

FROM employee

GROUP BY dept_ID

You defaulted the layout and choose a tabular report style. In the layout model which object will
enclose all the other layout objects?

Field

Master group frames
Repeating frame
Boiler plate

oOwp

Answer: B

QUESTION NO: 41
You need to add a pop-up menu to the CV_EMP canvas to display when a user right-clicks the mouse
within the canvas. How could you create the pop-up menu?

A. Use the Layout Editor to create a pop-up menu, assign commands to the menu in the Menu Editor,
and attack the menu items to the canvas.

B. Use the Report Wizard to create a pop-up menu and attack the menu items to the canvas.

C. Alter the pop-up Menu Property value in the Property Palette of the canvas.

D. Use the Object Navigator to create a pop-up menu, assign commands to the menu items, and attack
the menu to items or canvases.
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Answer: D

QUESTION NO: 42
You are creating a sales data template and need to add a picture to the margin. What is the best way
to add this margin?

Choose the margin code in the object navigator and select file->import->image.
Choose the margin node in the object navigator and use the tool bar button.
Click the margin button in the layout model and select file->import->image.
Click the margin button in the layout model and use the tool bar button.

Cawp>

Answer: C

QUESTION NO: 43

You are developing an inventory report for the purchasing department. To begin you creates this
query:

SELECT ID_number, description, quantity, unit_price, quantity* unit_price

‘amount’

FROM inventory

You need a report level total for the amount column. What is the best way to accomplish this task?

Alter the query to perform the calculation.

Create a formula column outside the default group.
Create a summary column outside the default group.
Create a formula column in side the default group.
Create a summary column in side the default group.
Create a place holder column outside the default group.

mmoaw>

Answer: C

QUESTION NO: 44

You have forgotten the name of binary PL/SQL library saved to the operating system. This file
contains the PL/SQL constricts you created for the inventory report. For which file extension should
you reach?

A. .SQL
B. PLL
C. PLD
D. .PRT
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Answer: B

QUESTION NO: 45

The transportation department requested a shipping cost report to list the resources used by each
department. A separate page should be product for each department. Which property would you
modify to achieve these results?

A. Minimum widow records.
Column mode.

Spacing

Print direction.

Source

Maximum records per page.

mmoaw

Answer: F

QUESTION NO: 46
You create the sales report and run it in the live previewer. After which change would the live

previewer require the data?

Removing column from the available list in the report wizard.

Removing the column from the displayed list in the report wizard.

Changing the display width of a column in the report wizard.

Adding a column to both the available list and displayed list in the report wizard.
Removing a column in the live previewer.

moQwx

Answer: D

QUESTION NO: 47
You creating a report that will run in both character mode and bitmapped environments. You include
some printer codes in your report. What will happen when you run the report in bitmapped mode?

The report will not execute.

The report will only accept destination type of previewer or printer.
Printer codes will be ignored.

Only the printer codes that apply will be processes.

Caowp>

Leading the way in IT testing and certification tools, www.testking.com

-58-



1z0-132

Answer: C

QUESTION NO: 48

You create a tabular employee report and are concerned about readability because the employee
records are very close together. What is the best way to increase the amount of white space between
the records?

In the layout model increase the size of the employee record fields.

In the report wizard increase the display width values of the employee record fields.

In the property palette increase the size of the repeating frame surrounding the employee records.
In the life previewer, high light a field, click on the parent frame icon and make the frame bigger
vertically.

Caowp>

Answer: D

QUESTION NO: 49

You are developing a tax report for the payroll application. You created a before parameter form
report trigger to create three temporary tables to store text that are need while the report is executed.
Which report trigger would you use to delete these temporary tables?

Before parameter form.
After parameter form.
Before report.

After report.

oSOwpx>

Answer: D

QUESTION NO: 50

You created a tabular report for the student housing authority that lists each student’s name, student
identification number, and dorm room number. The default setting prints each record below the
previous record.

Which two print setting could you use to print the student records to the right of the previous record
until an entire record cannot between the previous record and the right margin? (Choose two)

Across
Across/down
Down
Down/across
Matrix

moONwy
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Answer: A, B

QUESTION NO: 51

You are creating a tabular report to display each employee’s name, department, number and hire
date. You need to change the column data of the hire_date column to start date. In which window
could you complete this?

Data model.

Default layout window.

Field property palette.

Labels tab in the report wizard.
Field’s tan in the report wizard.

moONQwyx

Answer: D

QUESTION NO: 52
Which setting change would you allow to make a child object to be moved out of a parent object?

Flex mode on.
Flex mode off.
Confined mode on.
Confined mode off.

oCOowp>

Answer: D

QUESTION NO: 53

For an inventory report, you created a work_in_progress that contains two columns, ID_number and
quantity. The parent group of the work _in_progress is in_inventory which contains one column,
dept no. You added a filter of fist fifteen to total inventory and a filter of last 20 for
work_in_progress. Which records will the report return?

A. First 15 dept_no values.

B. Last 20 ID no and quantity values with the first 15 dept_no values for each work in_progress value.
C. First 15 dept no values with the last 20 ID_number and quantity values for each total inventory
value.

First 15 dept no values and the last 20 ID no and quantity values.

The last 20 ID_number and quantity values.

m o
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Answer: C

QUESTION NO: 54

You are creating a matrix report. Using query builder, you select the SALES _ID and DEPT_ID
columns from the SALES table, The CUST_BALANCE column from the CUSTOMER table and the
INVOICE_TOTAL column from the INVOICE table.

Using the report wizard you select SALES _ID as the row values, DEPT_ID as the column values and
SUM/CUST_BALANCE) as the cell values. You add a summary column for a SALES _ID row. If the
summary column has a null value you need to display a zero. What is the easiest way to accomplish
this task?

Alter the value if null property on the summary column property palette.

Alter the value if null property on the save_ ID palette.

Alter the initial value property on the sales ID property palette.

Create a format trigger for a summery value field to display a zero if the field is null.

Create a boiler plate text object in the layout model containing a zero and place it between the row
repeating frame and the matrix object.

moO 0w

Answer: A

QUESTION NO: 55
Which are SRW package procedure or function could you use to create and then drop a temporary

table in the sales report?

SRW.BREAK
SRW.SET ALTER
SRW.REFERENCE
SRW.DO SQL
SRW.RUN REPORT
SRW.SET FIELD

mmoawy

Answer: D

QUESTION NO: 56

You create a financial report to be represented to board of directors. The accounting manager has
asked you to change the number format to show a thousand separator. What is the best method to
make this change to the report quickly?

A. Open the property palette and set the format mask for all the numeric items in the report.
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B. Select the data to be free formatted in the life previewer and lick on the thousand separator icon on
the style bar.

Go to the layout model and change the field attributes for the data to be changed on the report.
Rebuild the report using the report wizard setting this format on creation.

SRS

Answer: B

QUESTION NO: 57
The sales report displays each sales person’s daily transactions. You need to add a total transaction
value for each sales person. What is the best way to add the summary value to existing report?

Reenter the report wizard and modify the query.

Reenter the report wizard and add the summary to the totals tab.
Reenter the report wizard and add the field to the data tab.

Add the summary column to the layouts using the layout model.
Recreate the report to add a summary value.

moO 0wy

Answer: B

QUESTION NO: 58
You need to add a page number to the bottom margin of your report pages. How would you navigate
to the margin area?

Use the menu options tool ->margin.

Click on the margin button.

In the layout models press <ALT>+<M>

This task can only be accomplished programmatically.

SNw

Answer: B

QUESTION NO: 59
Which three scenarios describe appropriate uses for key triggers? (Choose three)

A. Alter data in a database table.

Add custom item validation code.

Disable the Next Block key and menu item.

Display a custom form in place of a List of Values.

Change the navigational order of the blocks in a form.

Perform a complex calculation each time the F10 key is pressed.

mmoaw
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Answer: C,D, E

Note:

Section A contains 98 questions.
Section B contains 59 questions.

The total number of questions is 157.
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